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NWS Weather Event Simulator 4.0 Instructions Overview 
 

1. Back Up Any Pre-existing WES Installation 
2. Install WES4.0 
3. Verify Successful Installation 
4. Create a New WESSL Script for the 1997May01 Test Case 
5. Migrate Local AWIPS Customizations to WES4.0 
6. Create a New Localization for Your Local Case 
7. Link Local Customizations to All Other CWAs 
8. Create a New Localization for a Non-Local Case 
9. Create a New WESSL Script for a Case 
10. Create New FFMP Data for a Case 

 
 

Requirements: 
 

1. Redhat Linux7.2 using Gnome and Sawfish (already installed) 
 

 
The WES4.0 install CD is entirely self contained, and so it does not require any previous WES 
versions to be installed. If a previous version of WES was installed, the installation script will 
replace: 1) the WDTB WES software with WES4.0, 2) the Linux version of AWIPS with OB4.0, 
and 3) the COTS “freeware” software (in /usr/local).  
 
If you have not installed WES on the machine being used in the current installation, and you plan 
on having AWIPS data stored locally on your machine, then you will have to identify a large 
partition on a drive to store the files. Each case study generally occupies between 3.5 and 10.0GB 
of disk space, so it is suggested that you have a MINIMUM of 15GB of available space for both 
data and the WES4.0 distribution. Ideally, you will have 20GB+ set aside to handle multiple large 
datasets. The general convention for housing WES and WES data is to have /data and /awips be 
symbolic links that point to the install directory. The install script will guide you through this 
process.  The freeware in /usr/local is ~ 440 MB in size. 
 
If you have not successfully installed WES before, then you will need to configure your Linux 
display to support AWIPS D2D. In order to run D2D, your display should be in 24-bit Truecolor 
mode with a resolution of 1280x1024. You can check your current display with the "xdpyinfo" 
command. If you find that you need to change your display settings, run Xconfigurator. If you try 
to run D2D in 8-bit Pseudocolor mode the process will die a horrible death. 
 
Currently, WES4.0 runs under Redhat Linux7.2 (similar to the AWIPS operational baseline at time 
of this release) using the Gnome desktop and the Sawfish window manager. Deviating from these 
specifications can result in spontaneous log outs when a simulation is started (or when swapping 
panes in D2D), disappearing radar data on certain zoom factors, incorrect date resets, or other 
unforeseen problems. If you experience occasional spontaneous logouts with Redhat 7.2 you may 
need to contact WES support to update your driver or modify your Redhat kernel.  
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The WES4.0 package contains both NWS AWIPS software and WES© software. The WES© 
software was written by CIMMS personnel at the University of Oklahoma in collaboration with 
the Warning Decision Training Branch and others. Limitations exist on the distribution of this 
package, however, NWS collaborators may obtain WES4.0 at no cost by requesting a copy from 
the WES distribution focal point and by agreeing to the conditions of the WES© software license 
agreement in the install script. To submit a request for WES4.0 please contact Dr. Robert 
Rozumalski at COMET (roz@comet.ucar.edu) for more details. 
 
(c)Copyright, 2003 - Not to be provided or used in any format without the express written 
permission of the University of Oklahoma 

 
 

******************************************************************************* 
BACKUP 

******************************************************************************* 
 
1. Back Up Any Pre-existing WES Installation 

 
1. Log in as root. 
 
2. “cd /awips”. 
 
3. Back up the fxa directory as root: 
 

e.g. “cp -Rp fxa fxa.wes3.3” 
 
 

******************************************************************************* 
INSTALLATION 

******************************************************************************* 
 
2. Install WES4.0 

 
1.  Print out this file before starting if possible. 
 
2.  Log in as root. 

 
3.  Identify an install directory (e.g. /usr1) on a file system with 15GB+ of free disk space 

 
*Note: If you already identified an install directory for the previous WES installation, then 
use this same directory. The install script will notify you of the correct directory to use if you 
do not enter the same directory as in the previous WES installation. 

 
4. Load and mount the Weather Event Simulator 4.0 install CD. 
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5. e.g. “mount /mnt/cdrom” if the CD doesn't automatically mount 
 
6. Cd to your cdrom device (eg. “cd /mnt/cdrom”). 
 
7. Run “./install-wes4.0.sh <your_install_directory>”. 
 

*Note: The script will inform you about the files and directories that are going to be deleted. 
 

*Note: After agreeing to continue with the installation, wait for install-wes4.0.sh to return 
"install-wes4.0.sh finished" (~5-10 minutes). 

 
8. Logout and log back in as user fxa (if no fxa account previously existed, a new account was 

created by the install scripts with the password fxapass). 
 
 

******************************************************************************* 
VERIFICATION 

******************************************************************************* 
 
3. Verify Successful Installation 

 
1. D2D in OB4.0 will have problems viewing data from previous AWIPS builds, so in order to 

verify a successful installation, you will need to install a small test case in /data/awips from 
the WES4.0 install CD. 

 
*Note: You will eventually need to create new localizations for all your old cases (see 
Sections 5-8) before you can fully display them in D2D with the OB4.0 AWIPS in WES4.0. 
 
*Note: Your old cases (pre-OB3) will eventually need to be “fixed” for use with the OB4.0 
in WES because the radar data directory structure changed in AWIPS OB3. The WES 
software, start_awips and start_simulator (described later), will detect if the case needs to be 
fixed, and they will guide you through the process. 

 
2. Log in as fxa (if no fxa account previously existed, a new account was created by the install 

scripts with the password fxapass). 
 
3. As user fxa, load and mount the Weather Event Simulator 4.0 install CD. 
 

e.g. "mount /mnt/cdrom" if the CD doesn't automatically mount 
 
4. To install the test cases, cd to the CD device and run the wes4.0_testcase_install programs: 
 

e.g. “cd /mnt/cdrom” 
e.g. “./wes4.0_testcase_install” 
e.g. “./wes4.0_testcase_install2” 



 4

 
5. Ensure the radar data for the first test case were loaded correctly by viewing the ktlx 

“Z/SRM8” radar data in D2D. Start D2D by running “/awips/fxa/DRT/start_awips”, and 
select 1997May01 as the case. Then: 

 
-Click “OK” in start_awips 
-Click “Start” on the D2D launcher 
-After D2D starts up, select 32 in the “Frames” menu 
-Select “WFO” as the scale 
-Under the “ktlx” menu, select “All Tilts Z/SRM8” 
-Hold down the “Shift” key while using the arrow keys to go forward and backward in time 
 and up and down in space for multiple volume scans. 

 
*Note: The data in this case contains a limited number of volume scans of Z, SRM, DV, DZ 
and other miscellaneous data, including ~ 1.5 hours of DHR products from the ktlx radar for 
testing purposes. There is also ABRFC FFG data, an FFMP dataset created using the WES, 
and basin files for the ktlx radar in 1997May01/basin_files (in case you are interested in 
practicing FFMP data creation on the test case). 
 
*Note: All mouse clicks in the WES software are now single clicks. 

 
6. Display the FFMP data for ktlx and understand the limitations of FFMP in case review mode: 
 

-Under the “SCAN” menu in D2D select “FFMP Image / Basin Table” under the   
  “FFMP:ktlx” submenu 
-Click “Ok” on the binless basins caution popup window 
-A colored county map should appear. If it doesn’t, select 0.50 from the Durations (hr) menu, 
clear the pane, and reload the table 
-Find the basin with the most precipitation in Greer County by selecting “OK, GREER” in 
  the FFMPtable and then selecting “8001” in the basins list under the “Area_Id” 
-The “x” should be centered on the basin with the most precip (basin 8001) 
-Return to the county-level display by selecting the “County: OK, GREER” button 
-Select the “Link to Frame” button, and step through the loop using the “>” button in D2D 
-The table will display “N/A” for times when no accumulations exist for the selected duration 
  period 
-Return to the last frame in the loop by selecting the “>>|” button in D2D 
-Under the “durations (hr)” button select 1.00 and then select “Refresh D2D” 
-The table contents should change, but the D2D doesn’t update the county colors like it does 
  in real-time usage (map update also fails for “Thesh Type” and “Display Rate” changes) 
-The disconnect between the table and the D2D updating is a fundamental limitation of 
running FFMP and D2D without real-time AWIPS decoders running  

 
*Note: FFMP display in the D2D in AWIPS was not designed to run in case review mode 
without other real-time processors running. To enable full FFMP functionality, the case must 
be viewed after converting the case to DRT format and setting the start time in “Run 
Simulation”. At this time the AWIPS ingest processors are started, which contains what the 
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FFMP table is looking for to redraw the colors in the county map. 
 
*Note: Because FFMP data are stored differently than most AWIPS data (i.e. latest 6 hour 
accumulations in files with no time in the filenames), archived FFMP data won’t work 
directly with WES. Instead, a tool exists within WES to create FFMP data from basin files 
and archived datasets containing DHR files and AWIPS format flash flood guidance (FFG) 
(covered in Section 10). 

 
7. Display the SCAN storm cells table for ktlx: 

-Under the “SCAN” menu in D2D select “Storm Cells / Site Storm Threat” under the   
  “SCAN:ktlx” submenu 
-To get rid of the SCAN table, hit the clear button. 
 
*Note: For SCAN data to process you need to have the 1km CZ product. Some of the other 
products SCAN requires are 1km 0.5 degree Z, VIL, STI, M, and TVS. 
 
*Note: DMD data was unable to be created for this case, so the SCAN DMD table will not 
work. 

 
8. Shutdown D2D. 
 
9. Run “/awips/fxa/DRT/start_simulator” to begin to test a simulation on the 1997May01 

data. The case will need to be converted to DRT format, followed by running a simulation 
(see notes below). A simulation start time for this case (2346 UTC on May 01, 1997) has 
been set as the default in the new WES4.0 run simulation entry window along with a wessl 
file setting and an ffmp tar file setting (in future simulations the default will be the entry from 
the last time a simulation was run). 

 
*Note: If you have not run a simulation before, click on the “Help” menu (upper right 
portion of the simulator) and “Instructions” submenu, and follow the instructions under 
“Convert Case to DRT Format” and “Run Simulation”. For testing this test case you will not 
need to reselect the default entry fields. 
 
*Note: When the simulator prompts you to restart any D2D sessions, run 
“/awips/fxa/DRT/start_awips”. In the start_awips GUI select 1997May01 as the case, and 
select the “Want to start text windows needed for WarnGen?” checkbox. 

 
10.  Verify that a ktlx “All Tilts Z/SRM8” all tilts radar product updates (usually once per 

minute). 
 

*Note: Each minute the main WES window will update with data being processed, and 
updates in D2D should happen shortly after the WES window lists the files being processed. 
 
*Note: If the storm motion file doesn’t exist (as happens in a newly created localization) or if 
it becomes too old, a D2D popup warning message will appear when you first load the 
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product. You have to create a storm motion with the Radar Display Controls for the motion 
to be updated correctly. To change the storm motion: 

 
-toggle to the “SRM 8” product by selecting the “.” key on the numeric keypad. 
-under the “Tools” menu load “Radar Display Controls” 
-enter 270 degrees at 30 kts in the SRM Custom Storm Motion 
-trigger the display to update the new storm motion in the upper left part of the main pane by 
 zooming in on the storm or moving the center of the display 

 
11. Verify that a WESSL popup window appears each minute. Once the WESSL popups appear 

you can use the forward and backward buttons on the “WESSL Station Log” window to 
review previous WESSL popups. 

 
12. Test creating a warning with WarnGen in D2D: 
 

-clear the D2D pane and select a wfo scale map 
-with no product loaded click on the WarnGen button in the upper right part of D2D 
-move the "Drag me to storm" icon to somewhere in the center of the map 
-select Tornado for warning type in the WarnGen popup window 
-click on the "create text" button on WarnGen popup window 
-click “Acknowledge” to dismiss the ETN message that happens for the first warning 
-a text window should appear if the text monitor was started with D2D 
-click "Enter" to modify the warning 
-Replace the line at the bottom containing “!**NAME/INITIALS**!” with your initials 
-click the "Send" button and a popup message should appear 
-click "Go Ahead" when the popup window message appears. 
-in a new pane on wfo scale load “Local Warnings” from the NCEP/Hydro menu in D2D 
 
*Note: If you load a new warning polygon over old product data you may need to select 
“Forced” for the time matching in the upper left part of D2D for the time matching to work. 

 
13. In a shell window outside of D2D, list out the contents of the 

/data/awips/1997May01/flatText/OKCTOROKC directory containing the tornado warning 
just created (e.g. “ls /data/awips/1997May01/flatText/OKCTOROKC/”, and view the 
contents of the warning. The WarnGen products created during a simulation will be purged 
from this flatText directory when a new simulation is started. Essentially the files in the 
flatText directory are the replacement for storage in Informix. Non-WarnGen created PIL 
products can be included in a simulation through this flatText directory (OKCSAW1 for an 
SPC watch, for example) if: 

 
- the directory is created with the appropriate PIL name in the $FXA_DATA/flatText  
  directory, 
- the file is given a standard AWIPS filename convention, including seconds (e.g. 
19970501_210507), 
- and the data is put into the case before converting to DRT format. 
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In the current version, any “non-WarnGen” products added by the user using the instructions 
above are just made visible at the appropriate time, and there is no explicit notification with 
loops updating the products.  

 
14. Display the FFMP data for ktlx while in simulation mode: 

-Under the “SCAN” menu in D2D select “FFMP Image / Basin Table” under the  
  “FFMP:ktlx” submenu 
-Click “Ok” on the binless basins caution popup window 
-A colored county map should appear 
-Find the basin with the most precipitation in Greer County by selecting “OK, GREER” in  
  the FFMPtable and then selecting “8001” in the basins list under the “Area_Id” 
-The “x” should be centered on basin 8001, the basin with the most precip 
-Return to the county-level display by selecting the “County: OK, GREER” button 
-Select the “Link to Frame” button, and step through the loop using the “>” button in D2D 
-The table will display “N/A” for times when no accumulations exist for the selected duration  
  period 
-Return to the last frame in the loop by selecting the “>>|” button in D2D 
-Under the “durations (hr)” button select 1.00 and then select “Refresh D2D” 
-The table contents should change. In D2D, the colors of the counties should change, and the  
  legend in the upper left of the main D2D pane should update to include “1.0-Hour” 
-Under the “Thresh Type” button select ratio followed by “Refresh D2D” to update the  
  county map in D2D for the ratio product 
-Check the “Display Rate” box followed by “Refresh D2D” to view the rates on the D2D  
  display 
-Deselect the “Display Rate” box followed by refresh D2D to return to viewing the “Thesh  
  Type” selected earlier 

 
14. After verifying the install was successful, shut down D2D and exit the simulator. You may 

consider putting icons on the desktop to start the start_simulator and start_awips scripts. 
 
15. If you are interested in viewing DMD data in the second test case, then first ensure the radar 

data for the second test case were loaded correctly by viewing the ktlx “Z/SRM8” radar data 
in D2D. Start D2D by running “/awips/fxa/DRT/start_awips” and selecting 2004May19 as 
the case. Load the DMD product by selecting “Storm DMD Icons & Table” from the SCAN 
menu under “SCAN: klwx”. 

 
*Note: The data in this case contains a limited number of volume scans of DMD data and 
other miscellaneous data. There is no FFMP data in this case. 
 
*Note: Note that some things won’t work in case review mode, like the display filters. For 
full functionality try running a simulation. 

 
16. Run “/awips/fxa/DRT/start_simulator” to begin to test a simulation on the 2004May19 

data. The case will need to be converted to DRT format, followed by running a simulation 
(see notes below). To load a 1706z-1717z simulation, click on “Load Settings” and select 
“wes4.0_test_case_LWX”, and click “OK”. 
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*Note: When the simulator prompts you to restart any D2D sessions, run 
“/awips/fxa/DRT/start_awips”. In the start_awips GUI, select 2004May19 as the case. 

 
17. Load the DMD product by selecting “Storm DMD Icons & Table” from the SCAN menu 

under “SCAN: klwx”. 
 
18. Hold the left mouse button over one of the circles on D2D to see the cursor readout DMD 

output. 
 

19. Generate a time-ht rotational velocity plot by right clicking on a cell entry below llVr in the 
table. 

 
20. Threshold the display under the “Configurations” and  “D2D Display” submenus from the 

DMD table. Increase the thresholds by moving the yellow and red triangles to higher strength 
ranks and click “Apply”. 

 
21. For more information on DMD, see http://www.nws.noaa.gov/mdl/scan/ . 

 
******************************************************************************* 
CREATE A NEW WESSL SCRIPT FOR THE 1997May01 TEST CASE 
******************************************************************************* 
 
4. Create a New WESSL Script for the 1997May01 Test Case 

 
1. WESSL provides the ability to release non-awips data within a simulation using a scripting 

language. The simulation developer can create a new script either from scratch or by 
modifying an existing wessl file. WESSL4.0 was installed in /awips/fxa/DRT/wessl, and 
instructions/reference materials can be found through browsing the 
/awips/fxa/DRT/wessl/docs/index.html file. This section will focus on creating a new wessl 
file for the 1997May01 test case through modifying an existing wessl file. If you have 
already done this step in previous WES installations, then you may wish to skip section 4. 
Improvements in WESSL4.0 include map support for some sites outside the continental US. 

 
2. Run /awips/fxa/DRT/wessl/wessl/builder.tcl. 

 
3. Under the "File" menu select "Open". 

 
4. Use the directory navigator to navigate to the /data/awips/1997May01/wessl directory, and 

click on "oun_5-1-97.wessl". Then click the "Open" button. 
 

5. Under the "File" menu select "Save As". Then type in a new filename for the new WESSL 
script (e.g. newtest.wessl), and click on "Save". 

 
*Note: Files must be saved with the .wessl extension for them to eventually be selected in WES. 
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6. In the new WESSL script try modifying the "Simulation Has Started" text. With the blinking 
cursor on the modified line, click on the "Run" button in the upper right part of the interface 
to preview the command. 

 
7. Now try modifying the "23:47" line by changing the map latitude from "34.91" to "44.91", 

and delete "OUN". With the blinking cursor on the modified line, click on the "Run" button 
in the upper right part of the interface to preview the command. If you made both 
modifications, a new map will appear over the ABR CWA. 

 
8. In builder.tcl move the blinking cursor over the command line containing “23:46”. Click on 

the "Run" button in the upper right to step through each WESSL command until you reach 
the last command entry with the stop time of the simulation. 

 
9. Once you have stepped through the wessl commands, select “Save” under the “File” menu 

and "Build" under the "File" menu. 
 

10. When the builder is done building the script, list the new files created in your “wessl” 
directory (e.g. ls /data/awips/1997May01/wessl). 

 
11. Start a simulation in WES using the 1997May01 test case, and select the new WESSL file to 

run (e.g. newtest.wessl) next to the "WESSL Script (Optional)" label in the entry box. 
 

*Note: You do not need to select any WESSL Case Flags in the WES GUI unless you want 
to run only parts of the WESSL script. 

 
12. WESSL will launch the commands at the specified times during the simulation. The WESSL 

Station Log will allow the user to page through the WESSL pop ups. Building a new wessl 
script in a new case will be covered in Section 9. 

 
 

******************************************************************************* 
CUSTOMIZE AWIPS OB4.0 (based off of Dan Baumgardt's instructions) 
******************************************************************************* 
 
5.1 Migrate Local AWIPS Customizations to the WEScustomization Dir. On 
WES4.0 

 
1. These customization instructions were designed to transfer AWIPS customization files from 

a real-time AWIPS with Build OB4.0 to WES4.0. If you have already upgraded your WES 
with OB4.0 files following these instructions in WES1.3, you may move on to section 5.2. If 
you don’t have access to AWIPS customizations, then skip to Section 8. 

 
2. The concept of migrating customizations to WES4.0 is to transfer all your important 

customization files from your local AWIPS to a central location on WES (WEScustomization 
directory) that will not be removed by future WES installations. Section 5 needs to be 
completed with help from the local AWIPS focal point who understands how the local 
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AWIPS has been customized. To illustrate the following commands we will use the Chicago 
office, LOT, as the local CWA. 

 
3. Log in to your WES machine as user fxa. 

 
4. Identify a method to transfer files from your real-time AWIPS to your WES machine (floppy, 

cd, ftp, etc). 
 

5. If you have previously customized your WES using previous WES customization 
instructions, you will need to back up the customFiles, procs, global-LLL-files, storagefiles, 
mainConfig, and the XXX directory (eg. LOT) in the /awips/fxa/WEScustomizations 
directory before you update WES4.0 with your new OB4.0 customizations. 

 
e.g. “cd /awips/fxa/WEScustomization/” 
e.g. “mv customFiles customFiles.ob3.3” 
e.g. “mv procs procs.ob3.3” 
e.g. “mv global-LLL-files global-LLL-files.ob3.3” 
e.g. “mv storagefiles storagefiles.ob3.3” 
e.g. “mv mainConfig mainConfig.ob3.3” 
e.g. “mv LOT LOT.ob3.3” 

 
6. Copy the /data/fxa/customFiles directory on your DS into the /awips/fxa/WEScustomization 

directory on the WES. 
 

e.g. “cp -R customFiles /awips/fxa/WEScustomization” from cd 
 

7. Copy the /data/fxa/procs directory on your DS into the /awips/fxa/WEScustomization 
directory on the WES machine. 

 
e.g. “cp -R procs /awips/fxa/WEScustomization” from cd 

 
8. Copy the /awips/fxa/data/localization/XXX directory (where XXX is your localization ID) on 

your LX1 workstation to the /awips/fxa/WEScustomization directory on your WES machine. 
The directory on the LX1 machine should contain the most up to date localization files which 
were used for the installation of OB4.0. 

 
e.g. “cp -R LOT /awips/fxa/WEScustomization” from cd 

 
9. Copy the following files from your DS to the /awips/fxa/WEScustomization/storagefiles 

directory:  
 

/awips/fxa/data/localization/nationalData/virtualFieldTable.txt 
/awips/fxa/data/localization/nationalData/gridPlaneTable.txt 
/awips/fxa/data/colorMaps.nc 
/awips/fxa/data/fxa-users 
/data/fxa/workFiles/customColorMaps.nc 
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10. Change the permissions on the colorMaps.nc file to “-rw-rw-rw” if they aren’t set this way: 
 

e.g. “chmod 666 /awips/fxa/WEScustomization/storagefiles/colorMaps.nc” 
 
11. Copy the following files from your WS to the /awips/fxa/WEScustomization/storagefiles 

directory: 
 

/awips/fxa/data/vb/browser*.txt (not needed if browser*.txt files are already in the 
customFiles directory). 

 
12. Copy a LINUX VERSION of any specialized map files (*.bcx found in the 

/awips/fxa/data/localizationDataSets/XXX directory) into the 
/awips/fxa/WEScustomization/storagefiles directory. 

 
13. Copy any other relevant local customized files to the 

/awips/fxa/WEScustomization/storagefiles directory. 
 

5.2 Migrate the Local AWIPS OB4.0 Customizations to the New OB4.0 with 
WES4.0 

 
1. The following instructions assume you have copied over your AWIPS customizations to the 

WEScustomization directory per the 5.1 instructions.  
 
2. Identify a local case with your CWA to create a localization for in /data/awips. To illustrate 

the following commands, we will use a 2002Jun12 case from the LOT CWA as an example. 
 

3. If you have already applied steps 4, 5, 6, and 7 in a previous WES customization using 
WES1.1-WES1.3 customization instructions, you can skip steps 4, 5, 6, and 7. 

 
4. As user fxa, backup your customFiles, procs, and userPrefs directory in your case: 
 

e.g. “cd /data/awips/2002Jun12” 
“mv customFiles customFiles.orig” 
“mv procs procs.orig” 
“mv userPrefs userPrefs.orig” 

 
5. Make a customFiles symbolic link in your data case that points to the customFiles directory in 

WEScustomization: 
 

e.g. “ln -s /awips/fxa/WEScustomization/customFiles 
/data/awips/2002Jun12/customFiles” 

 
6. Make a procs symbolic link and userPrefs symbolic link in your data case that points to the 

procs directory in WEScustomization: 
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e.g. “ln -s /awips/fxa/WEScustomization/procs /data/awips/2002Jun12/userPrefs” 
“ln -s /awips/fxa/WEScustomization/procs /data/awips/2002Jun12/procs” 

 
7. Cd to the data case, and list out the contents of the links to ensure the links resolve the 

appropriate directories and files in /awips/fxa/WEScustomization. 
 

e.g. “cd /data/awips/2002Jun12” 
“ls customFiles” 
“ls procs” 
“ls userPrefs” 

 
8. “cd /awips/fxa/data/localization” and backup your local CWA XXX directory: 

 
e.g. “mv LOT LOT.orig” 

 
9. While in the same directory as step 8 (/awips/fxa/data/localization), make an XXX symbolic 

link (where XXX is your local CWA) that points to the pre-localization directory in 
WEScustomization: 

 
e.g. “ln -s /awips/fxa/WEScustomization/LOT LOT” 
 

10. List out the contents of the XXX link in /awips/fxa/data/localization/ created in step 9 to 
ensure the link resolves the appropriate directories and files in 
/awips/fxa/WEScustomization. 

 
e.g. “ls /awips/fxa/data/localization/LOT” 

 
11. Before copying any of the following files into the WES AWIPS, make a backup version of 

the file you are copying over. 
 

“cd /awips/fxa/WEScustomization/storagefiles”, and copy: 
 
            file:     to location: 
virtualFieldTable.txt  /awips/fxa/data/localization/nationalData 
gridPlaneTable.txt  /awips/fxa/data/localization/nationalData 
browser*.txt    /awips/fxa/data/vb (not needed if in customFiles) 
fxa-users    /awips/fxa/data 
customColorMaps.nc  /data/awips/{$case_name}/workFiles 
 
where {$case_name} refers to your case (eg. 2002Jun12). 

 
12. Copy any other relevant files in the storagefiles directory to the appropriate AWIPS 

directory. 
 
13. Now you are ready to create a localization for your local case. 
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******************************************************************************* 
CREAT A NEW LOCALIZATION FOR YOUR LOCAL CASE 
******************************************************************************* 
 
6. Create a New Localization for Your Local Case 

 
1. A new AWIPS localization usually needs to be created for every major AWIPS build 

upgrade, or when you create a case from scratch. If you have not customized your WES 
(Section 5), the localization you create will contain all the AWIPS default settings for color 
tables, templates, etc. 

 
*Note: If you try to use an old localization on a newer version of AWIPS associated with a 
new WES install, D2D will typically hang on the startup. 

 
2. Cd to your localizationDataSets directory in your local case. 
 

e.g. “cd /data/awips/2002Jun12/localizationDataSets” 
 
3. Move any old localization you are going to recreate. 
 

e.g. “mv LOT LOT.ob3.3” 
 
4. “cd /awips/fxa/data/localization/scripts” and run mainScript.csh with your localization ID: 
 

e.g. “mainScript.csh LOT LOT” 
 
*Note: You will be prompted to enter your case name and verify it is correct. 

 
5. When mainScript.csh is done, “cd /awips/fxa/WEScustomization/storagefiles”. 
 
6. Copy any colorMaps.nc and *.bcx files from the /awips/fxa/WEScustomization/storagefiles 

directory to your new localization in /data/awips/{$case_name}/localizationDataSets/XXX, 
where {$case_name} is your local case (e.g. 2002Jun12) and XXX is your localization (e.g. 
LOT). 

 
7. Start D2D with the new localization, and verify your localization was successful and any 

customizations took effect. Once you have verified your localization was successful, then try 
running a simulation to test creating a warning with WarnGen. 

 
8. To update other local cases with the new customizations, first create the links in the new case 

that point to the WEScustomization subdirectories (ie. steps 4-7 in Section 5.2) if they 
haven’t been created. Then, back up the customColorMaps.nc file and XXX localization in 
the new case (we will now use 2002Jun12 as the old local case and 2003Feb01 as the new 
local case from LOT in the following command examples): 
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eg. “cd /data/awips/2003Feb01/workFiles” 
      “mv customColorMaps.nc customColorMaps.nc.ob3.3” 
      “cd /data/awips/2003Feb01/localizationDataSets” 
      “mv LOT LOT.ob3.3” 

 
9. Then copy the customColorMaps.nc and new XXX localization into the new local case: 
 

eg. “cp /data/awips/2002Jun12/workFiles/customColorMaps.nc 
       /data/awips/2003Feb01/workFiles” 
 
      “cp -R /data/awips/2002Jun12/localizationDataSets/LOT        
      /data/awips/2003Feb01/localizationDataSets” 

 
10. If you would like to be able to create localizations for other CWAs that contain your 

WarnGen templates, color tables, etc, then complete Section 7. 
 
 
******************************************************************************* 

LINK LOCAL CUSTOMIZATIONS TO ALL OTHER CWAS 
******************************************************************************* 
 
7. Link Local CWA Customizations to All Other CWAs 

 
1. This section provides instructions on how to create localizations for other CWAs that will 

contain your local WarnGen templates, color tables, etc, so you can train like you fight on 
cases outside your CWA. In the following example we will use LOT as the local CWA that 
will be customizing the BMX localization for the 1998Apr08 Birmingham, AL case in 
/data/awips/1998Apr08. 

 
2. The approach to making customized localizations other than your CWA involves linking all 

relevant local customization files to all the other CWAs before running mainScript.csh. 
 

3. Log in as user fxa, and choose a case (e.g. 1998Apr08) to make a new localization for (e.g. 
BMX) that is not your local CWA. 

 
4. If you have already made a customFiles symbolic link, a procs symbolic link, and a userPrefs 

symbolic link in this data case (steps 4, 5, 6, and 7 from Section 5.2) that points to the 
appropriate directories in WEScustomization then skip steps 5, 6, and 7. 

 
5. Back up your customFiles, procs, and userPrefs directory in your case: 
 

e.g. “cd /data/awips/1998Apr08” 
“mv customFiles customFiles.orig” 
“mv procs procs.orig” 
“mv userPrefs userPrefs.orig” 
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6. Make a customFiles symbolic link in your data case that points to the customFiles directory 
in WEScustomization; make a procs symbolic link and userPrefs symbolic link in your data 
case that points to the procs directory in WEScustomization: 

 
eg. “ln -s /awips/fxa/WEScustomization/customFiles 
/data/awips/1998Apr08/customFiles” 
“ln -s /awips/fxa/WEScustomization/procs /data/awips/1998Apr08/userPrefs” 
“ln -s /awips/fxa/WEScustomization/procs /data/awips/1998Apr08/procs” 

 
7. Cd to the data case, and list out the contents of the links to ensure the links resolve the 

appropriate directories and files in /awips/fxa/WEScustomization. 
 

e.g. “cd /data/awips/1998Apr08” 
“ls customFiles” 
“ls procs” 
“ls userPrefs” 
“cd /awips/fxa/WEScustomization/customFiles”. 
 

8. Copy the XXX-* files (e.g. LOT-*) in your customFiles directory that do not contain local 
geographic information to the global-LLL-files directory: 

 
eg. “cp LOT-wwaConfig.template /awips/fxa/WEScustomization/global-LLL-files” 
 
*Note: Do not copy files to this directory that have geographic information unique to your 
CWA like XXX-radarsInUse.txt, XXX-radarsOnMenu.txt, XXX-mainConfig.txt, 
XXXdialRadars.txt, and XXX-mosaicInfo.txt. Try doing a more command on each XXX-* 
file and watch for local radar information or local/surrounding CWA information to check 
for files not to copy. See Appendix A for an example of the file list in global-LLL-files. 
 
*Note: Any files in customFiles without the XXX- prefix will be utilized in the new 
localization directly from the customFiles directory. 

 
9. Check the customFiles directory for files without an XXX- prefix that contain local 

geographic information unique to your CWA like radarsInUse.txt, radarsOnMenu.txt, 
mainConfig.txt, dialRadars.txt, and mosaicInfo.txt. If you find such files in this directory, 
then rename them with an XXX- prefix (e.g. mv dialRadars.txt LOT-dialRadars.txt). See 
Appendix A for an example of the file list in customFiles. 

 
10. “cd /awips/fxa/WEScustomization/XXX” where XXX is your localization ID (e.g. LOT). 

 
11. Copy any XXX-* files and generic files (no XXX- prefix) that do not contain local 

geographic information to your /awips/fxa/WEScustomization/global-LLL-files directory. 
 

eg. “cp LOT-wwaConfig.template /awips/fxa/WEScustomization/global-LLL-files” 
 



 16

*Note: Do not copy files to this directory that have geographic information unique to your 
CWA like dialRadars.txt, XXX-dialRadars.txt, XXX-radarsInUse.txt, 
XXXradarsOnMenu.txt, XXX-mainConfig.txt, XXX-mosaicInfo.txt, etc. Try doing a “more” 
command on each XXX-* file and watch for local radar information or local/surrounding 
CWA information to check for files not to copy. See Appendix A for an example of the file 
list in global-LLL-files and in the /awips/fxa/WEScustomization/XXX directory. 

 
12. Run “/awips/fxa/WEScustomization/scripts/linkLLLfiles.csh” to put symbolic links in 

every /awips/fxa/data/localization/LLL directory that point to each file in 
/awips/fxa/WEScustomizations/global-LLL-files. 

 
*Note: When you want to make changes to global-LLL-files, modify the files in the global- 
LLL-files directory, and run the unlinkLLLfiles.csh script followed by linkLLLfiles.csh. 

 
13. If you have generic directives (e.g. @@@RADAR_Z 1000) in your XXX-mainConfig.txt 

file you will need to create a new file in step 15 that will be accessed for localizing other 
CWAs (this is not a bad thing). 

 
14. Copy your XXX-mainConfig.txt file from /awips/fxa/WEScustomization/XXX to the file 

/awips/fxa/WEScustomization/mainConfig/genericmainConfig.txt. 
 

e.g. “cp /awips/fxa/WEScustomization/LOT/LOT-mainConfig.txt 
/awips/fxa/WEScustomization/mainConfig/genericmainConfig.txt” 

 
15. Remove any local geographic directives from the genericmainConfig.txt file, leaving only 

generic directives (e.g. leave only entries like “@@@RADAR_Z 1000” in the 
genericmainConfig.txt file). See Appendix A for an example of the genericmainConfig.txt 
file. 

 
16. Run “/awips/fxa/WEScustomization/scripts/modifymainConfig.csh” to create a new 

XXX-mainConfig.txt file in each pre-localization directory in /awips/fxa/data/localization. 
 

*Note: If in the future you want to return the XXX-mainConfig.txt files to the original in 
each of the pre-localization directories, run the unmodifymainConfig.csh program in the 
same directory. 

 
17. The next section (Section 8) will cover how to make the customizations in Section 7 take 
effect. 
 
 

******************************************************************************* 
CREAT A NEW LOCALIZATION FOR A NON-LOCAL CASE 
******************************************************************************* 
 
8. Create a New Localization For a Non-local Case 
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1. A new AWIPS localization usually needs to be created for every major AWIPS build, or 
when you create a case from scratch. If you have not customized your WES (Section 5 and 
Section 7), the localization you create will contain all the AWIPS default settings for color 
tables, templates, etc. 

 
*Note: If you try to use an old localization on a newer version of AWIPS associated with a 
new WES install, D2D will typically hang on the startup. 

 
2. Before running mainScript.csh, back up the localization if it exists: 
 

e.g. “cd /data/awips/1998Apr08/localizationDataSets” 
“mv BMX BMX.ob3.3” 

 
3. “cd /awips/fxa/data/localization/scripts” and run mainScript.csh on the new localization 

you are about to create. 
 

e.g. “mainScript.csh BMX BMX” 
 

*Note: You will be prompted to enter your case name and verify it is correct. 
 
4. If you are customizing your WES from your AWIPS, then backup the customColorMaps.nc 

file in your case, and copy the customColorMaps.nc file from the storagefiles directory into 
the workFiles directory in your case. If you are not customizing your WES from your 
AWIPS, then skip steps 4-6. 

 
e.g. “cd /data/awips/1998Apr08/workFiles” 
e.g. “mv customColorMaps.nc customColorMaps.nc.orig” 
e.g. “cp /awips/fxa/WEScustomization/storagefiles/customColorMaps.nc .” 

 
5. After mainScript is done, “cd /awips/fxa/WEScustomization/storagefiles”. 
 
6. Copy any colorMaps.nc and *.bcx files from the /awips/fxa/WEScustomization/storagefiles 

directory to your new localization in /data/awips/{$case_name}/localizationDataSets/XXX, 
where {$case_name} is the new case (e.g. 1998Apr08) and XXX is the new localization (e.g. 
BMX). 

 
7. Start D2D with the new localization to verify your localization works and any customizations 

were successfully applied. If your localization was successful then try running a simulation to 
test creating a warning with WarnGen. 

 
8. Once you have verified all your customizations took effect, you can easily create a new 

localization for any CWA in this case (e.g. FFC) by running mainScript.csh (step 3 with FFC 
for example) and following steps 5 and 6 (using FFC for example). 

 
e.g. “mainScript.csh FFC FFC” 
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9. To create a new localization with no customization changes (ie. you skipped Sections 5 and 
7) on any new case (e.g. /data/awips/1998May31 Albany, NY event at ALY), all you need to 
do is back up the old localization (step 2 using ALY) and run mainScript.csh (step 3 using 
ALY). 

 
10. To create a new localization with customization changes (ie. you completed Sections 5 and 7) 

on another case outside your CWA (e.g. /data/awips/1998May31 Albany, NY event at ALY), 
now all you need to do is back up the customization directories in the case (step 5 in Section 
7 using /data/awips/1998May31), make symbolic links in the data case that point to the 
appropriate directories in WEScustomization (step 6 in Section 7 using 
/data/awips/1998May31), verify the links (step 7 in Section 7 using /data/awips/1998May31), 
back up the old localization (step 2 in Section 8 using ALY), run mainScript.csh (step 3 in 
Section 8 using ALY), and copy files into the new localization (steps 4, 5, and 6 in Section 
8). 

 
 

******************************************************************************* 
CREAT A NEW WESSL SCRIPT FOR A CASE 

******************************************************************************* 
 
9. Create a New WESSL Script for A Case 

 
1. This section focuses on using the test case wessl file as a template to build a new wessl file 

for a new case. This section assumes a new localization has already been built in Section 6 or 
Section 8. 

 
2. Make a “wessl” directory for your new WESSL source files in your data case if it doesn't 

exist (e.g. mkdir /data/awips/1998Apr08/wessl). The “wessl” directory must be all lowercase 
letters. 

 
3. Run /awips/fxa/DRT/wessl/wessl/builder.tcl. 

 
4. Under the "File" menu select "Open". 

 
5. Use the directory navigator to navigate to the /data/awips/1997May01/wessl directory, and 

click on "oun_5-1-97.wessl". Then click the "Open" button. 
 

6. Under the "File" menu select "Save As". Then navigate to the new “wessl” source file 
directory created in step 2 above (i.e. /data/awips/1998Apr08/wessl). Now type in a new 
filename for the new WESSL script (e.g. bmx_4-8-98.wessl), and click on "Save". 

 
*Note: Files must be saved with the .wessl extension for them to eventually be selected in 
WES. 

 
7. In the new WESSL script try changing the time and date in the first line (23:46 05/01/97) to 

the start time and date of your case. Also modify the "Simulation Has Started" text. With the 
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blinking cursor on the modified line, click on the "Run" button in the upper right part of the 
interface to preview the command. 

 
8. Modify the time in the “23:47” line, delete OUN, and try using the Lat/Lon readout in D2D 

on your data case to put in appropriate values for your data case (to find lat-lon values right 
click on a map background in D2D to select “Lat/Lon Readout” and use the left mouse 
button to read out a lat-lon value on a map). With the blinking cursor on the modified line, 
click on the "Run" button in the upper right part of the interface to preview the command. 

 
9. In builder.tcl move the blinking cursor over the command line containing the start time of 

your new simulation. Click on the "Run" button in the upper right to step through each 
WESSL command until you reach the last command entry with the stop time of the 
simulation. 

 
10. Once you have stepped through the wessl commands, select “Save” under the “File” menu 

and "Build" under the "File" menu. 
 

11. When the builder is done building the script, look at the new files created in your “wessl” 
directory (e.g. ls /data/awips/1998Apr08/wessl). 

 
12. Start a simulation in WES, and select the new WESSL file to run (e.g. bmx_4-8-98.wessl) 

next to the "WESSL Script (Optional)" label in the entry box. 
 

*Note: that you do not need to select any WESSL Case Flags unless you want to run only 
parts of the WESSL script. 

 
******************************************************************************* 

CREAT NEW FFMP DATA FOR A CASE 
******************************************************************************* 
 
10.1 Preparing a Case for FFMP 

 
1. Because FFMP data are stored differently than most AWIPS data (i.e. latest 6 hour 
accumulations in files with no time in the filenames), archived FFMP data won’t work directly 
with WES. Instead, a tool exists within WES to create FFMP data from archived datasets. Before 
WES can be used to create FFMP data, the case needs to be prepared for FFMP. These 
instructions will work for local cases or cases from other CWAs. 
 
2. To create FFMP data from an archived case requires the following:  

a. basin files for each radar running FFMP (stored in 
/awips/fxa/data/localization/nationalData) 

b.  HRAP grid digital RFC flash flood guidance (stored in 
<your_case>/img/SBN/netCDF/HRAP/FFG/XXRFC/Yhr where XXRFC is the RFC 
for your area and Yhr is 1hr, 3hr, and 6hr)  

c. DHR files for each radar running FFMP stored in 
<your_case>/radar/xxxx/DHR/layer0/res1/level256 (where xxxx is the radar name) 
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d. Directories: <your_case>/tstorm, <your_case>/radar/xxxx/tstorm, 
<your_case/radar/xxxx/ffmp (where xxxx is the radar name), and 
<your_case/radar/xxxx/ffmp/lookupFiles 

e. A localization run with the “-scan” switch 
 

*Note: Failure to include all of the above elements will result in bad FFMP data. 
 
*Note: The FFMP directory structure changed in OB4, so all FFMP data sets created with 
WES before WES4.0 will require the files in each radar’s ffmp directory to be copied to a 
“lookupFiles” subdirectory, followed by relocalizing with the scan switch: 
 
e.g. “mkdir /data/awips/1997May01/radar/ktlx/ffmp/lookupFiles” 
       “cp /data/awips/1997May01/radar/ktlx/ffmp/* 
/data/awips/1997May01/radar/ktlx/ffmp/lookupFiles” 
       “mainScript.csh  –scan OUN OUN” 

 
3. The first step in preparing your case for FFMP is to copy the basin files for each radar onto 

your WES. For your local cases, you should already have basin files on your AWIPS. Basin 
files from other radars will have to be retrieved from other NWS offices or the AWIPS 
NOAA1 server. 

 
4. On your LX workstation copy the basin files to the WES (e.g. copy files to a tmp directory 

and burn a cd): 
 

e.g. “cd /awips/fxa/data/localization/nationalData” 
e.g. “cp ktlx_* /data/fxalocal/tmp” and burn a cd 

 
5. As outlined in the Section 5.1, copy these files to the 

/awips/fxa/WEScustomization/storagefiles directory to preserve the files on the machine in 
the WES upgrades 

 
e.g. “cp /mnt/cdrom/ktlx_* /awips/fxa/WEScustomization/storagefiles” 

 
6. Copy the basin files to the /awips/fxa/data/localization/nationalData directory 
 

e.g. “cp /awips/fxa/WEScustomization/storagefiles/ktlx_* 
/awips/fxa/data/localization/nationalData” 

 
7. After copying the basin files to the WES machine, you need to ensure the FFG data exists in 

the case. 
 

e.g. “ls <your_case>/img/SBN/netCDF/HRAP/FFG/XXRFC/Yhr where XXRFC is the 
RFC for your area and Yhr is 1hr, 3hr, and 6hr) 

 
8. Ideally you will want to always include FFG data in your regular local archive, since there is 

no easy-to-access archive source for the digital FFG data. If you are trying to recreate old 
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FFG files, you can check with the COMET case study group to see if they have access to the 
data (note that digital FFG data in general is not available prior to 1999 because that is when 
it was distributed via the SBN). If you can access some digital FFG data that is somewhat 
representative for your case there is a way to configure that to work with FFMP (see 
Appendix B), though not having the exact FFG data for that case can significantly change the 
way FFMP characterizes events. 

 
9. After ensuring FFG data exists in your case, ensure DHR data exists for each radar to run 

FFMP. 
 

e.g. “ls <your_case>/radar/xxxx/DHR/layer0/res1/level256” (where xxxx is the radar 
name) 

 
10. Ideally you will want to always include the DHR product on your RPS list and in your local 

archive. If you wish to create DHR data from archived level II data, you can try using Paul 
Jendrowski’s programs available from the SOO/STRC website. 

 
11. After ensuring DHR files exist in the case, ensure the required directories exist. 
 

e.g. “ls <your_case>/tstorm” 
“ls <your_case>/radar/xxxx/tstorm” (where xxxx is the radar name) 
“ls <your_case/radar/xxxx/ffmp” (where xxxx is the radar name) 
“ls <your_case/radar/xxxx/ffmp/lookupFiles” (where xxxx is the radar name) 

 
 
12. If the directories do not exist in your case, copy a version of these directories over from a 

case that has them, or your local AWIPS (or create them manually as a last resort). 
Recreating a localization (step 13) should update all the files needed for the particular case. 

 
13. After ensuring the case structure is ready for FFMP, create a new localization for your case 

running mainScript.csh. 
 

e.g. mainScript.csh OUN OUN 
 
14. Once the localization is done, relocalize with the scan switch to create all the needed FFMP 

configuration files. 
 

e.g. mainScript.csh –scan OUN OUN 
 
15. Start up D2D and check the SCAN menu to verify the FFMP menus exist for the radars you 

have configured FFMP to run. If the radar isn’t listed, you will need to include the desired 
radar in XXX-radarsInUse.txt and XXX-radarsOnMenu.txt files in your customFiles 
directory in the case (where XXX is your localization id for the case). 
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16. While in D2D, select the “FF” button on the upper right, and ensure a reasonable “FFG 
Expiration Time” exists (e.g. 96 hours), and click “Save”. If the “FFG Expiration Time” is 
blank, FFMP will not be able to access the FFG data needed to create FFMP data. 

 
17. Under the “Maps” and “FFMP Basins” submenu on the D2D, select the “kxxx Small Stream 

Basins” map, where kxxx is the radar name. If all the needed basin files were included in 
nationalData, and the localization was rerun, the high resolution basin maps should display. 

 
10.2 Creating an FFMP Tar File for WES 
 
1. Once the case is prepared for FFMP creation (Section 10.1), the WES can be used to create 

FFMP data. The case can be in original format or DRT format when creating the data. The 
FFMP data is stored as tar files that are subsequently selected in the simulation entry window 
(e.g. 19970507_2346.tar.gz). 

 
2. The time of the ffmp tar file represents the end of the ffmp accumulations. For example, a 

19970507_2346.tar.gz file contains data up to 2346Z. During a simulation the 
FFMPprocessor will create new data each volume scan to add to the existing accumulations. 

 
*Note: To browse FFMP data in a static mode, you can create an ffmp tar file for the end of the 
time period of interest. If you are running FFMP data in a simulation you will want to create data 
up to the start time of the simulation, and the FFMPprocessor will add to the accumulations each 
volume scan during the simulation. 
 
3. Start up WES4.0 using “/awips/fxa/DRT/start_simulator”, and click on the “Tools” button, 

followed by the “Create FFMP Dataset” button. 
 

4. Select the case (FXA_DATA), localization (FXA_LOCAL_SITE), and start time of your 
planned simulation (FFMP start time), and click the “OK” button. While you are waiting for 
FFMP data to be created, you may watch the progress of the FFMP processor in the shell 
window used to launch the simulator. 

 
5. FFMP data will be created for the 96 DHR files leading up to the start of the simulation (size 

of the FFMP storage). It does this by feeding a subset of the DHR files to the FFMPprocessor 
and other decoders started during the data generation. If you have multiple radars and many 
DHR files, the process can take 5-10 minutes. The WES has been programmed to warn the 
user if some of the requirements in Section 10.1 are not met. 

 
*Note: It is very important not to kill the simulator while it is creating FFMP data. If you kill 
the simulator while the FFMP data is being created, the …DHR/layer0/res1/level256.saved 
directory will need to be renamed to “level256” after removing “level256” and 
“level256ffmp”. Be careful not to delete your original data directory. 

 
6. Following a successful FFMP data creation, a tar file is created for each radar’s ffmp 

directory with the time stamp entered in the FFMP start time. The tar files are subsequently 
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selected from the WES main simulation entry window, and they reside in 
<your_case>/radar/xxxx/ffmptars (where xxxx is the radar). 

 
7. Verify the FFMP data was created correctly by starting up D2D and loading the FFMP table 

for one of the valid radars. If there is no FFMP data in your case, then review any error 
messages and contact WES support. Note that the FFMP table won’t function entirely until a 
simulation is started (explained in Section 3). 

 
8. After the data have been verified to exist, the FFMP tar file needs to be selected in the main 

simulation entry window. 
 

9. In the main “Run Simulation” entry window next to “FFMP File and Radars”, click on the 
“Select” button, and select a radar to be used. 

 
10. A list of tar files should pop up. Select the desired tar file time, and click “OK”. 

 
11. The tar file selected should appear in the main simulation entry window along with a list of 

radars that have tar files at that time. Selecting one tar file from one radar will grab all the 
available tar files from other radars. Click “OK” to proceed with the simulation startup. 

 
12. After the links are created for the simulation start time, each radar’s ffmp directory is deleted, 

and a new directory is untarred into its place with the data valid up to the start time. 
 

13. Note that most of the AWIPS decoders are also started in this step. 
 

14. Before clicking on “Run Simulation” in the Verification Entry window, you may start D2D 
and view the new FFMP datasets with full FFMP table functionality. 

 
15. If you wish to run a simulation, you may click “Run Simulation”, and you will need to restart 

D2D. The FFMPprocessor is then started for simulation use, and each time the DHR files are 
processed by WES, a notification is sent to the FFMPprocessor and other AWIPS processes 
to create new FFMP data and update the table as in real time. 
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Appendix A 

 
Example of files in WEScustomization subdirectories for a localization with the id XXX are 
given below. Note that your file list will vary due to local differences in customization practices. 
 
1./awips/fxa/WEScustomization/global-LLL-files 
 
XXX-acqPatternAddOns.txt 
XXX-backgroundMenus.txt 
XXX-commonLdadMenus.txt 
XXX-localDataKeys.txt 
XXX-localDepictKeys.txt 
XXX-localProductButtons.txt 
XXX-radarDataMenus.template 
XXX-sls_county_block.preTemplate 
XXX-wwaConfig.template 
XXX-wwaDefaults.txt 
XXX-wwa_ffw.preWWA 
XXX-wwa_flflood_sta.preWWA 
XXX-wwa_svr2.preWWA 
XXX-wwa_svr.preWWA 
XXX-wwa_svrwx_sta.preWWA 
XXX-wwa_tor.preWWA 
XXX-wwa_wrksls.preWWA 
XXX-wwa_wrksls.wwaProd 
 
*Note: You should not have files in this directory (with or without XXX- prefixes) that have 
local geographic information in them like XXX-radarsInUse.txt, radarsInUse.txt, 
XXXradarsOnMenu.txt, XXX-mainConfig.txt, XXX-dialRadars.txt, XXX-mosaicInfo.txt, etc. 
 
2./awips/fxa/WEScustomization/XXX 
 
dialRadars.txt 
XXX-acqPatternAddOns.txt 
XXX-commonLdadMenus.txt 
XXX-commonLdadMenus.txt.bad 
XXX-dialRadars.txt 
XXX-eta12.sup 
XXX-hydroSiteConfig.txt 
XXX-mainConfig.txt 
XXX-portInfo.txt 
XXX-pupId.txt 
XXX-radarDataMenus.template 
XXX-radarsInUse.txt 
XXX-radarsOnMenu.txt 
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XXX-spotters.goodness 
XXX-wwaConfig.template 
XXX-wwaConfig.txt 
XXX-wwa_counties.master 
XXX-wwa_counties.patch 
XXX-wwa_zones.master 
XXX-wwa_zones.patch 
 
*Note: Because this directory is for your local CWA (XXX in this example), and it is not shared 
with other localizations, you may have files in this XXX directory that have local geographic 
information with or without the XXX- prefix like radarsInUse.txt, XXX-radarsInUse.txt, 
radarsOnMenu.txt, mainConfig.txt, dialRadars.txt, mosaicInfo.txt, etc. 
 
3./awips/fxa/WEScustomization/customFiles 
 
activeGridSources.txt 
arrowStyle.rules 
browserFieldMenu.txt 
contourStyle.rules 
eta12.cdl 
eta12.sup 
gridImageStyle.rules 
gridPlaneTable.txt 
iconStyle.rules 
LocalCitiesInfo.txt 
localGridSourceTable.txt 
MTR.goodness 
MTR.primary 
XXX-backgroundMenus.txt 
XXX-dialRadars.txt 
XXX-localDataKeys.txt 
XXX-localDepictKeys.txt 
XXX-localProductButtons.txt 
XXX-mainConfig.txt 
XXX-mosaicInfo.txt 
XXX-radarsInUse.txt 
XXX-radarsOnMenu.txt 
XXX-sls_county_block.preTemplate 
XXX-wwa_cem.preWWA 
XXX-wwa_dam_break.preWWA 
XXX-wwaDefaults.txt 
XXX-wwa_ffw.preWWA 
XXX-wwa_flflood_sta.preWWA 
XXX-wwa_svr2.preWWA 
XXX-wwa_svr.preWWA 
XXX-wwa_svrwx_sta.preWWA 
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XXX-wwa_tor.preWWA 
XXX-wwa_wrksls.preWWA 
XXX-wwa_wrksls.wwaProd 
radarDataMenus.template 
radarDepictKeys.template 
radarProductButtonInfo.template 
SiteChangesLog 
virtualFieldTable.txt 
WWA_aircraft.preWWA 
WWA_alert1.preWWA 
WWA_alert2.preWWA 
WWA_blizzard_wrn.preWWA 
WWA_blodust_adv.preWWA 
WWA_blodust_wrn.preWWA 
WWA_blosnow_adv.preWWA 
WWA_coast_fld_stmt.preWWA 
WWA_coast_fld_wat.preWWA 
WWA_coast_fld_wrn.preWWA 
WWA_esf.preWWA 
WWA_excheat_wrn.preWWA 
WWA_extheat_wat.preWWA 
WWA_extheat_wrn.preWWA 
WWA_ffld_wat.preWWA 
WWA_ffld_wrn.preWWA 
WWA_ffs.preWWA 
WWA_flood_wat.preWWA 
WWA_flood_wrn.preWWA 
WWA_fog_adv.preWWA 
WWA_freeze_adv.preWWA 
WWA_freeze_wrn.preWWA 
WWA_frost_adv.preWWA 
WWA_frost_wrn.preWWA 
WWA_frzdrzl_adv.preWWA 
WWA_frzrain_adv.preWWA 
WWA_frzrain_wrn.preWWA 
WWA_hazard_outlk.preWWA 
WWA_heat_adv.preWWA 
WWA_heat_outlook.preWWA 
WWA_hiwind_wat.preWWA 
WWA_hiwind_wrn.preWWA 
WWA_hurricane_wat.preWWA 
WWA_hurricane_wrn.preWWA 
WWA_hvysnow_wrn.preWWA 
WWA_icestrm_adv.preWWA 
WWA_icestrm_wrn.preWWA 
WWA_mws.preWWA 
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WWA_now.preWWA 
WWA_npw.preWWA 
WWA_pns.preWWA 
WWA_pub_info.preWWA 
WWA_rec_evt.preWWA 
WWA_redflag_wat.preWWA 
WWA_redflag_wrn.preWWA 
WWA_severe_outlook.preWWA 
WWA_short.preWWA 
WWA_slt_adv.preWWA 
WWA_slt_wrn.preWWA 
WWA_smoke_adv.preWWA 
WWA_snow_adv.preWWA 
WWA_specialstmt.preWWA 
WWA_svrstmt.preWWA 
WWA_svrt_wat_sls.preWWA 
WWA_svrt_wat_wcn.preWWA 
WWA_tor_wat_sls.preWWA 
WWA_tor_wat_wcn.preWWA 
WWA_tropstorm_wat.preWWA 
WWA_tropstorm_wrn.preWWA 
wwa_urbssflood_adv.preWWA 
WWA_volash_adv.preWWA 
WWA_volash_wrn.preWWA 
WWA_wcn.preWWA 
WWA_wind_adv.preWWA 
WWA_wintstrm_wat.preWWA 
WWA_wintstrm_wrn.preWWA 
WWA_winwea_adv.preWWA 
WWA_wndchil_adv.preWWA 
WWA_wndchil_wrn.preWWA 
WWA_wsr88d.preWWA 
WWA_wsw.preWWA 
WWA_ww_outlk.preWWA 
 
*Note: For files in the customFiles directory without the XXX- prefix you should not have files 
that contain local geographic information in them like radarsInUse.txt, radarsOnMenu.txt, 
mainConfig.txt, dialRadars.txt, mosaicInfo.txt, etc. 
 
4. /awips/fxa/WEScustomization/mainConfig 
 
genericmainConfig.txt (with the following entries inside the genericmainConfig.txt file): 
 
@@@RADAR_Z 1000 
@@@RADAR_V 1002 
@@@RADAR_8 1018 
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Appendix B 
 

Creating FFG Data for an Old Case From Recent FFG Data 
 

1. If you have an old case, and you have some digital FFG data from a recent event that is 
reasonable to use, you may modify the files to work with the old case. 

 
2. Copy the FFG files into your case as outlined in section 10.1. 

 
3. For each file you will need to create a new FFG netCDF file with the modified time. 

 
4. Use “ncdump” to create a text version of the file to modify. The following examples will 

illustrate creating a 19910426_1200.multi file from a 19970501_1200.multi file. 
 

e.g. “ncdump 19970501_1200.multi > tmp.txt” 
 
5. Determine the time of the new FFG data you wish to create (e.g. 19910426_1200). 
 
6. Create a file, newtime.txt, with the time entered in the following format: ss mm hh dd MM 

YYYY where ss is the seconds, mm is minutes, hh is hour, dd is day, MM is month, and 
YYYY is year (e.g. 00 00 12 26 04 1991). 

 
7. Obtain the julian seconds from 1970 for this time by running 

“/awips/fxa/DRT/calJulSecFrom1970.linux < newtime.txt” 
 

8. Edit the text version of the FFG data (e.g. “vi tmp.txt”) and replace the integer following 
“validTime =” with the new julian seconds from 1970 time calculated in step 7, and save the 
file. 

 
9. Create a new netCDF file from your modified text file using ncgen. 
 

e.g. “ncgen –o 19910426_1200.multi tmp.txt” 
 
10. Remove all the old files just leaving the updated FFG file. 
 
11. Start D2D, and verify the FFG data is visible, and that it loads the appropriate time. 

 
12. Repeat the process for each FFG file in the 1hr, 3hr, and 6hr directories. 

 
13. If the data are displaying correctly, try creating new FFMP data with Section 10. 
 

*Note: If the integer seconds time is entered incorrectly inside the file, the data will still display 
correctly, but the FFMPprocessor will fail to time match the FFG data when new data is created 
with WES. 


